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All the accounting you need to know 
 Chart of accounts 

o The chart of accounts is a complete list of your business’ accounts and their balances 

 When you keep books for a company, you want to track: 

o Where the income comes from 

o Where you put it 

o What the expenses are for 

o And what you use to pay them 

 You track this flow of money through the chart of accounts 

 

 

About assets, liabilities, and equity: 

 Assets 

o Include what you have and what people owe you 

o The money people owe you is called your accounts receivable, or A/R for short.  

Quickbooks uses an accounts receivable account to track the money owed you. 

o The rest of your company’s assets may include checking accounts, sacings accounts, 

petty cash, fixed assets (such as equiptment), inventory, and undeposited funds. 

 Libabiliteis 

o What your company owes to other people 



Page 4 of 41 
 

o The money you owe for unpaid bills is your accounts payable, or A/P for short.  

Quickbooks uses an accounts payable account to track the money you owe different 

people for bills. 

o A liability can be a formal loan, an unpaid bill, or sales and payroll taxes you owe to the 

government. 

 Equity 

o Equity is the difference between what you have and what you owe 

o Equity = Assets – Liabilities 

Cash versus accrual bookkeeping: 
 Cash basis 

o Incoming is recorded when money (sales) is received and expenses when money (bills) 

are paid 

 Accrual basis  

o Income is recorded when at the time of the sale and expenses when you receive the bill 

Note: When you create reports is Quickbooks, you can switch between cash and accrual reports at any 

time, regardless of which bookkeeping method you have chosen for tax purposes. 

Measuring business profitability 
 The balance sheet 

o A snapshot of your company on one date.  It shows: 

 What you have (assets) 

 What people owe you (accounts recivable) 

 What your business owes (liabilities and accounts payable) 

 The net worth of your business (equity) 

 The profit and loss statement 

o A profit and loss statement or income statement shows income, expenses, and net 

profit or loss 

 Statement of cash flows 

o Shows receipts and payments during  aspecific accounting period 

General journal transactions: 
 Traditional accounting method 

 Known as double-entry accounting 

 Total amount in the Debit column equals the total amount in the Credit column 

 Each amount is assigned to an account in the chart of accounts 

 To view the journal entry for a transaction, select the transaction and press Ctrl-Y 

 Modify the report and choose to display the Credit and Debit columns 
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Adding Customers 
In order to bill customers with Quickbooks, you need to add your customers 

1. Click Customer Center in the icon bar 

2. Click the New Customer & Job menu button, and then choose New Customer 

3. If the New Feature screen for Add/Edit Multiple List Entries appears, click the box for “Do not 

display this message in the future” and click OK. 

4. In the Customer Name field, enter the name of the customer as you'd like it to appear on your 

Customers & Jobs list. For this exercise, type Smith, Lee, and then press Tab. You want the list to 

show last names first. 

5. Press Tab in the Opening Balance field to leave this field blank. 

The Opening Balance field tells you how much each customer owes you on your start date so 

that when you enter the rest of your transactions from your start date to today, all balances 

since your start date will be accurate. For now, leave this field blank. Lockhart Design is planning 

to set up one or more jobs for this customer. QuickBooks will calculate and track the overall 

balance for this customer from the balances you enter for the individual jobs. 

6. In Address Info tab, click in the First Name field and type Lee. 

7. Press tab and type M. as the middle initial and in the Last Name field, type Smith. 

8. Press Tab to go to the Address field, and then press Enter after Lee M. Smith. 

9. Type 43 Hampshire Blvd and press Enter. 

10. Type East Bayshore, CA 94327. 

11. Click the Copy button to copy the address to the Ship To field. Click OK in the Add Shipping 

Address Information window. You can have and use more than one Ship To address per 

customer or job, but Lee Smith uses only one address. 
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To add a job for a customer 
1. In the Customers & Jobs list, right-click Smith, Lee and choose Add Job. The New Job window 

looks similar to the Customer window. QuickBooks has already filled in several fields for you for 

Lee Smith. 

2. In the Job Name field, type Patio, and press Tab. 

3. In the Opening Balance field, type 862 and press Tab. 

You want to keep track of the balances for each job. QuickBooks calculates and tracks the overall 

balance for this customer from the balances you enter for the individual jobs. You want to keep track of 

the balances for each job. 

Note: The information QuickBooks fills in comes from your customer's record. If you make any changes 

here, the changes affect only this job. For example, if your customer's billing address is different for this 

job, you can enter the job address without affecting the customer's main address. 

4. Enter 12/31/2019 in the As Of field to indicate that this was the balance outstanding for this job 

as of the QuickBooks start date. 

5. Click the Job Info tab and choose “In Progress” from the Job Status drop-down list. 
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Job status information is for your records—it gives you a way to keep track of each job. When 

you create a customer list report, QuickBooks includes the status of each job on the report. You 

can also see the status of a job by clicking a job in the Customers & Jobs list and looking in the 

Job Information area. 

6. For the Start Date, type 12/15/19 and press Tab. 

7. In the Projected End date, type 3/15/20 and press Tab. 

 

 

The dates help you track how long each job takes and how well you are able to estimate the length of a 

job. When you create a customer:job list report, you can add columns that show the start date, your 

projected end date, and the actual end date for each job. 

Your screen should resemble the following graphic: 

 

Adding vendors 
In order to pay your bills with QuickBooks, you need to add your vendors. Nearly everyone you pay, 

other than employees, is a vendor. 

You can add new vendors at any time. QuickBooks uses the Vendors list to hold information about the 

people and companies you do business with; for example, this list could include the phone company, 

your office supplies vendor, and your tax board. 

To add a vendor: 

1. Click Vendor Center in the icon bar. 

2. Click the New Vendor menu button, then choose New Vendor. 

3. In the Vendor Name field, enter the name of the vendor as you'd like it to appear on your 

Vendor list. For this exercise, type Fay, Maureen Lynn, CPA, and then press Tab. 

4. In the Opening Balance field, type 350, which is the amount you owed this vendor as of the start 

date. Press Tab. 

5. In the As Of field, enter 12/31/19. 

6. In the Address Info tab, click in the First Name field and type Maureen. 

7. Press tab and type L. as the middle initial and in the Last Name field, type Fay. 
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8. Press Tab to go to the Address field, and then press Enter after Maureen L. Fay. 

9. Type 200 Royal Rd. and press Enter. 

10. Type Bayshore, CA 94326. 

 

Adding a new account 
You may need to add one or more of the following accounts: 

 Income accounts to track new sources of income. 

 Expense accounts to track new types of expenses. 

 Bank accounts when you open new checking, savings, or money market accounts at your bank. 

 Credit card accounts when you acquire new credit cards. 

 Other kinds of balance sheet accounts to track specific assets, liabilities, or equity. 

For example, you may need to add a fixed asset account to track the depreciation of a new equipment 

purchase, a long term liability account to track a business loan, or an equity account to track the 

investment from a new business partner. 

A complete list of your business’ accounts and their balances appear in the chart of accounts. You use a 

chart of accounts to track how much money your company has, how much money it owes, how much 

money is coming in, and how much is going out. 
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To add an income account 
1. From the Lists menu, choose Chart of Accounts. 

2. Click the Account menu button and choose New. 

3. In the Add New Account window, choose Income, and then click Continue. 

4. Click in the Account Name field, and type Consulting. 

5. From the Tax-Line Mapping drop-down list, choose “Income: Other income.” 
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Adding items  

In QuickBooks, an item is anything that your company buys, sells, or resells in the course of business, 

such as products, shipping and handling charges, discounts, and sales tax (if applicable). You can think of 

an item as something that shows up as a line on an invoice or other sales or purchase form.  

Items help you fill out the line item area of a sales or purchase form quickly. When you choose an item 

from your Item list, QuickBooks fills in a description of the line item and calculates its amount for you.  

While they provide a quick means of data entry, a much more important role for items is to handle the 

behind-the-scenes accounting. When you create an item, you link it to an account; when the item is 

used on a form, it posts an entry to that account and another entry to the appropriate accounts 

receivable, accounts payable, checking, fixed asset, or other account.  

When creating items, consider how much detail you want on your invoices or statements and set up 

items with that level of detail in mind. For example, if you are a seamstress who creates and sells home 

accessories, you can set up a single item and charge a flat rate for a certain size of couch pillow, or you 

can break that pillow down further into labor and materials.  

QuickBooks provides several different types of items. Some—such as the service item or the inventory 

part item—help you record the services and products your business sells. Others—such as the subtotal 

item or discount item—are used to perform calculations on the amounts in a sale. 
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1. From the Lists menu, choose Item List. 

QuickBooks displays the Item List. 

2. Click the Item menu button, and choose New. 

3. In the New Item window, choose Service from the Type drop-down list. 

4. Click in the Item Name/Number field and type Initial Design Consultation. 

5. In the Description field, type Initial design consulting. 

The description will appear on sales forms when you use the item. 

6. Click in the Rate field, and type 40. 

7. In the Tax Code field, choose “Non-Taxable Sales” from the drop-down list. 

8. In the Account field, choose Consulting. 

 

 

Writing A Quickbooks Check 
To write a check: 

1. In the Banking area of the Home page, click Write Checks. 

2. In the Pay to the Order of field, type Cal Telephone. 

3. Press Tab to move to the Amount field.  

4. Type 156.91, and press Tab. 
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5. Click in the Account column on the Expenses tab, and then choose Utilities: 
Telephone. 

6. Click Save & Close. 

7. From the Banking menu, choose Use Register. 

 

Using Bank Account Registers 
To open a register (when no form is open): 

1. From the Lists menu, choose Chart of Accounts. 
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2. In the Chart of Accounts, double-click the Savings account. 

 

3. Review features common to all registers: 

o The register shows every transaction that affects an account’s balance and 
lists them in chronological order (unless another order is chosen in the Sort 
by drop-down box in the lower left corner of the register window).  
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o The columns in the register give specific information about the transaction.  
o On every transaction line, QuickBooks shows the account’s running balance 

4. Close the Savings register window. 

5. Close the Chart of Accounts. 

Entering a Handwritten Check 
Sometimes you need to write a check on the spot for items or services you did not plan to purchase. 

QuickBooks lets you write the check, and then enter it later in the checking account register or on the 

check form. 

To enter a handwritten check in the checking account register: 

6. From the Banking menu, choose Use Register. 

7. Click OK to accept Master Checking Account. 

8. Click in the Number field in the blank transaction at the bottom of the register, 
and then double-click to highlight the number that QuickBooks prefills.  

9. Type 1204, then press Tab. 

10. In the Payee field, type Bayshore Office Supply, and then press Tab. 

11. Click Quick Add. 

 

12. Click OK 

13. In the Payment field, type 99.95, and then press Tab. 

14. In the Account field, type Of, and press Tab (QuickBooks fills in Office 
Supplies). 
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15. In the Memo field, type Office chair. 

 

16. Click Record. 

17. Close the Checking account register. 

When you record the transaction, QuickBooks creates a journal entry. 

 

Reconciling Checking Accounts 
Your bank sends you a statement for each of your accounts each month. The statement shows all the 

activity in your account since the previous statement: 

• Opening balance 

• Ending balance 

• Amount of interest earned 

• Service charges 

• Checks that have cleared the bank 

• Deposits made 

• Other transactions affecting the balance of the account 
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Marking Cleared Transactions 
To begin reconciling an account, you need to tell QuickBooks which account you want to reconcile. Then 

you can provide information from the top part of your bank statement. 

 

1. From the Banking menu, choose Reconcile. 

2. In the Account field, make sure Master Checking Account is selected. 

3. In the Statement Date field, type 11/30/2019. 

4. In the Ending Balance field, type 75574.08 

 

 

5. Click Continue. 

6. Place a check mark in the 

Hide transactions after 
statement’s end date. 
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Using Sales Forms 
For payments in the future 

Any time you make a sale in your business, you record it in QuickBooks on a sales form. A sales form can 

be an invoice (when you expect payment to come later), a sales receipt (when you expect payment at 

the time you make the sale), or a credit memo. 

The type of sales form you use depends on whether you expect payment in the future or at the time of 

the sale. If you expect to receive payment at some future date, you enter an invoice.  

To display a completed invoice form in QuickBooks: 

1. Click the Create Invoices icon on the Home page. 

2. Click Previous to display the previously created invoice 

For Payment at the Time of Sale 
If you receive full payment at the time you make a sale—either by cash, check, or credit card—you fill 

out a sales receipt instead of an invoice. Like the invoice, the QuickBooks sales receipt includes 

information about the items or services purchased, but it also includes information about how payment 

was made. 

To display a completed sales receipt in QuickBooks: 

1. Click Create Sales Receipts on the Home page. 

2. If the Integrated Payment Process window appears, click No Thanks or Show me later. 

3. Click Previous to view the previously entered sale.  
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Memorizing a Sale 
Many of the sales you make in your business are ones you repeat again and again. For example, you may 

have a standing monthly order from a customer, or you may perform essentially the same services for 

more than one client. QuickBooks lets you memorize sales forms so that you don’t have to retype the 

information. 

To memorize the invoice: 

1. Make sure you have the invoice you want to memorize displayed on your screen. 

2. From the Edit menu, choose Memorize Invoice. 

3. In the Name field, type a description that helps you recognize the memorized invoice, or keep 

the default description QuickBooks has provided. 

4. Click OK. 

5. Close the Create Invoice, Accounts Receivable, and the Chart of Accounts windows.  
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To recall a memorized sale 
1. From the Lists menu, choose Memorized Transaction List. 

2. Double-click the transaction you just added. 

3. Click Save & Close to record the invoice. 

4. Press the Esc key to close the Memorized Transaction list. 

 

Entering a New Service Item 
When you begin using your own QuickBooks company file, you’ll need to create your own line items to 

include on your invoices. In the next exercise, you’ll see how to add information to the Item list. 

To create a new service item: 

1. From the Customers menu, choose Item List. 

2. Click the Item menu button, and then choose New. 

3. In the Type field, select Service from the drop-down list. 

4. In the Item Name/Number field, type Plumbing. 

5. Click the Subitem of checkbox to select it. 

6. In the drop-down list below the Subitem of field, select Repairs.  
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Generating Reminder Statements 
Reminder statements summarize a customer's account with a company by listing recent invoices, credit 

memos, and payments received. You can use reminder statements when you bill through invoices but 

want to remind your customers about delinquent payments. 

Reminder statements are different than other “forms” in QuickBooks such as invoices, sales receipts, or 

checks. Because QuickBooks already has all the information you need to create reminder statements, 

you don't have to fill them out. Instead, you review the information that will appear on each statement, 

decide whether to add finance charges, and print them. 

To generate reminder statements: 

1. Click Home to display the Home page, then click Statements. 

2. In the Enter Statement Date and Type section of the window, select the All open transactions as 

of Statement Date option. 

3. Click to select the Include only transactions over checkbox. 

4. Leave the number of days past due field entry at 30. 

5. In the Select Customers section, select All Customers. 

6. In the Select Additional Options section, click to select the Show invoice item details on 

statements checkbox. 
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Recording Payment In Full For A Single Job 
If you’re receiving payment at the time of a sale, and you fill out a sales receipt, QuickBooks records a 

customer payment. When you invoice a customer, and you receive payment later, you enter the 

payment in the QuickBooks Receive Payments window. 

To record a payment in full: 

1. From the Customers menu, choose Receive Payments. 

2. If the QuickBooks Payment Interview window displays, close it. 

3. In the Received From field, select Violette, Mike: Workshop from the drop-down list. 

4. Press Tab to move to the Amount field. 

5. In the Amount field, type 4735.73 and press Tab. 

6. In the Payment Method field, select Check from the drop-down list and then press Tab. 
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7. In the Check # field, type 6745. 

 

8. Click Save & New. 

 

Entering A Partial Payment 
To enter a partial payment: 

1. In the Received From field, select Ecker Designs: Office Repairs from the drop-down list. 

2. Press Tab to move to the Amount field and type 1000, then press Tab again. 

3. In the Pmt. Method field, leave Check selected. 

4. In the Check # field, type 5678. 

5. Click Un-Apply Payment. 

6. In the Payment column, type 1000 as the amount you want to apply to the second invoice, 

and then press Tab. 

7. Leave the Leave this as an underpayment option selected. 

8. Click Save & New to record the partial payment and clear the window 
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Applying One Payment To Multiple Jobs 
To apply one payment to multiple jobs: 

1. In the Receive Payments window, select Cook, Brian from the Received From drop-down 

list. 

2. Press Tab to move to the Amount field. 

3. In the Amount field, type 7812.63 and then press Tab. 

4. In the Pmt. Method drop-down list, confirm that Check is selected. 

5. In the Check # field, type 375. 
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6. Click Save & New. 

 

Entering Overpayments 
If a customer sends you an overpayment, you simply enter the amount in the Receive Payments 

window, and QuickBooks keeps track of the additional payment. When the customer has future 

invoices, you can apply the overpayment to those amounts—you can even apply the credit directly to 

the invoice. 

To enter the payment: 

1. In the Received From field of the Receive Payments window, select Pretell Real Estate:75 

Sunset Rd. from the drop-down list. 

2. Press Tab and type 12500 in the Amount field. 

3. Press Tab again. 

4. Select the Refund the amount to the customer option. 
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5. Click Save & New. 

 

 
6. In the Issue a Refund window, click OK. 

 

Handling Down Payments & Prepayments 
If a customer makes a payment before you’ve invoiced him for services (for example, he may be making 

a down payment or paying a retainer fee), you can still record the payment at the Receive Payments 

window. However, because you don’t have any invoices to which to apply the payment, QuickBooks 

records the payment as an unused payment (just like an overpayment). 

QuickBooks holds the unapplied amount with the customer’s name. The next time you enter that 

customer in the Receive Payments window, QuickBooks displays the credit amount in the Unused 

Credits area. The customer’s balance also reflects the credit amount. 

To enter the down payment you’ve received: 

1. In the Received From field, select Abercrombie, Kristy: Kitchen from the drop-down list and 

then press Tab. 

2. Type 1000 in the Amount field and then press Tab. 

3. In the Pmt. Method field, make sure Check is selected. 

4. In the Check # field, type 4321. 

5. Leave the Leave the credit to be used later option selected. 
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6. Click Save & Close. 

 

 
 

7. Click OK in the message that displays. 

 

To create an invoice for a customer who made a down payment: 

1. From the Customers menu, choose Create Invoices. 

2. In the Customer:Job field, select Abercrombie, Kristy: Kitchen from the drop-down list. 

3. QuickBooks displays the Available Estimates window. You don’t want to create the invoice 

from the estimate listed, so click Cancel. 

4. From the Template drop-down list, choose Custom Invoice. 

5. Click in the Item column, select Removal from the Item drop-down list, and then press Tab. 

6. In the Quantity column, type 40 and press Tab. 
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7. Notice that the $1000 payment you entered appears in the Recent Transactions list of the 

Customer Snapshot. 

8. Click Apply Credits to apply the down payment amount made earlier toward this invoice. 

9. Click Yes at the message that displays to save changes.  
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10. This is the credit that you want to apply to the invoice, so click Done. 

 
11. Click Save & Close to record the transaction. 

Making Deposits 
When you use the Enter Sales Receipt window (for a sales receipt where you receive payment on the 

spot), the Receive Payments window (for payments on invoices), or a payment item on an invoice, 

QuickBooks keeps track of the money you’ve received until you deposit it in the bank. When you receive 

payments from customers, you can either deposit each payment directly into a QuickBooks bank 

account or you can group payments together into an account called Undeposited Funds to be moved to 

that bank account at a later time. QuickBooks allows you to choose the method you prefer for 

depositing payments. 

To select payments to deposit: 
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1. From the Banking menu, choose Make Deposits. 

 
2. Click to select the payments you want to bring to the bank. 

 
3. Click OK. 

QuickBooks displays the Make Deposits window, which shows the payments you just 

selected. 

4. In the Deposit To field, make sure that Master Checking Account is selected. 
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If you have money to deposit that is not the result of a payment you received for a sale, you 

can enter it in the detail area of the window. For example, if you received a premium refund 

from your insurance vendor, you would enter it here. 

5. Click Save & Close to record the deposit. 

 

How Quickbooks Handles The Deposit 
To view the Undeposited Funds account: 

1. From the Lists menu, choose Chart of Accounts. 

2. In the Chart of Accounts, double-click the Undeposited Funds account. 
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3. Close the account register window. 

4. In the Chart of Accounts, double-click the checking account. (Note the amounts in the balance 

column may be different than what is shown in the image below). 

 

5. Close the checking account register and the Chart of Accounts. 
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Using Quickbooks For Accounts Payable 
Some business owners, especially if they own smaller, home-based businesses, pay their bills when they 

receive them. Most business owners, however, find it more convenient to pay bills less often. (They also 

like keeping the cash in the company for as long as possible.) If you don’t plan on paying your bills right 

away, QuickBooks can help you keep track of what you owe and when you owe it. 

The money you owe for unpaid bills is called accounts payable. QuickBooks uses the Accounts Payable 

account to track all the money you owe. Like any QuickBooks balance sheet account, the Accounts 

Payable account has a register where you can view all your bills at once. 

To see the Accounts Payable register: 

1. From the Lists menu, choose Chart of Accounts. 

2. Double-click Accounts Payable in the list to open the register. 

 

The register keeps track of each bill you have entered, shows you the due date, and keeps a running 

balance of all the bills you owe. As a business owner, this helps you forecast your cash flow, and the 

QuickBooks reminder system helps you pay your bills on time. 

3. Press Esc twice to close the open windows. 

Entering Bills 
When you receive a bill from a vendor, you should enter it into QuickBooks as soon as you can. This 

keeps your cash flow forecast reports up to date and doesn’t give you the chance to set aside a bill and 

forget about it. 

To enter a bill: 
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1. From the Vendors menu, choose Enter Bills. 

 
2. In the Vendor field, type Willis Advertising, and then press Tab. 

3. When QuickBooks displays a message telling you that Willis Advertising is not on the Vendor 

list, click Quick Add. 

4. In the Amount Due field, type 1500. 

5. Click in the Bill Due field. 

6. Click in the Account column on the Expenses tab and type Printing. 

7. Press Tab to accept Printing and Reproduction as the account. 

8. Type 1450 to change the amount from 1,500 to 1,450. 

9. Click in the Account column below Printing and Reproduction. 
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10. From the drop-down list, choose Freight & Delivery, and then press Tab. 

 
11. Click Save & Close to record the bill.  

 

Paying Bills 
When you start QuickBooks or open a QuickBooks company file, a Reminders window appears that tells 

you whether you have transactions to complete, such as bills to pay or money to deposit. (If you don’t 

see the Reminders window, turn it on by choosing Preferences from the Edit menu.) 

When QuickBooks tells you that you have bills due, you can display the Pay Bills window and select the 

bills you want to pay. 

To pay a bill: 
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1. From the Vendors menu, choose Pay Bills. 

 
2. Select the To be printed option. 

3. Select the Willis Advertising bill by checking the box in the column to the left of the bill. 

4. Click Pay Selected Bills. 

5. You could print the checks at this point, but for this exercise click Done. 

 

How Quickbooks Records Your Bill Payment 
When you pay $1,500 on a bill through the Pay Bills window, QuickBooks makes an entry in the accounts 

payable register, showing a decrease of $1,500 in the total payables. It also creates a check from your 

checking account to pay the bill. 

To see the entry in the accounts payable register: 

1. From the Company menu, choose Chart of Accounts. 

2. In the Chart of Accounts, double-click the Accounts Payable account. 
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3. Close the accounts payable register. 

 

To see the entry: 

1. In the Chart of Accounts, double-click Master Checking Account. 

 

2. Select the Willis Advertising transaction. 

3. On the toolbar, click Edit Transaction. 
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4. From the Window menu, choose Close All to close all the open QuickBooks windows. 

5. Click Home in the icon bar to open the Home page. 

Creating New Templates 
QuickBooks lets you customize an invoice form to suit the needs of your business, but there may be 

times when you want to design a completely different invoice form. QuickBooks lets you do that, too. 

You can use the Layout Designer to create a new form design for your business. In the Layout Designer, 

you can move, resize, or change the width of columns, turn on or off borders around fields, and control 

font type and size for each field. 

To create a new invoice template: 



Page 38 of 41 
 

1. From the Lists menu, choose Templates. 

 
 

2. Click the Templates menu button, and then choose New. 

3. Click OK to select the invoice form. 

4. Click the Manage Templates button to give the template a name. 

5. In the Template Name field, type My Invoice. 

6. Look at the options in the Logo & Fonts section of the Basic Customization window.  

7. In the Company & Transaction section, select the Phone Number checkbox.  

8. Select the Do not display this message in the future checkbox, and then click OK. 

9. Leave the Basic Customization window open. You’ll use it in the next exercise. 

Customizing Fields On Forms 
To customize fields on a template: 
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1. Click the Additional Customization button at the bottom of the window. 

 
2. To have the Due Date field display both on screen and on the printed form, click the Screen 

checkbox for Due Date to select it.  

3. Click the Print checkbox for Due Date.  

4. Clear the Screen and Print checkboxes for the P.O. No. field to remove the field from the 

form.  

Changing The Position Of Fields On Forms 
To move fields on forms: 

1. From the Lists menu, choose Templates. 

2. Right click on My Invoice and select Edit Template. 

3. Click Layout Designer. 
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4. Click the Bill To field. 

5. Press and hold the Shift key. 

6. Click the field directly below the Bill To field (the field containing the words This is sample 

text). 

7. Release the Shift key. 

8. With the cursor over the selected fields, press and hold the left mouse button. 

9. Drag the selected fields down about one inch. 

10. Release the mouse button. 
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11. Select the field containing Rock Castle’s address. 

12. Move the mouse over one of the dark squares on the bottom of the field and then hold the 

mouse button while you drag the bottom of the field up to a point just below the address—

the goal being to get rid of the extra space below the address so you can place the phone 

number directly beneath it. 

13. Scroll to the bottom of the screen and select the Phone # field. 

14. Right click and click Remove. 

15. Select the field containing the numbers 555-555-5555. 

16. Holding down the mouse button, drag the field so that it sits just below Rock Castle’s 

address. 

 


